
GETTING STARTED GUIDE

NI DCM-2316
Embedded Direct Injector Control and Measurement (DCM) Device 
with Real-Time Processor and Reconfigurable FPGA

Hazardous Voltage This device sources hazardous voltages up to 250V. You must 
take the following precautions. A hazardous voltage is a voltage greater than 42.4 
Vpk voltage or 60 VDC to earth ground.

Caution Ensure that hazardous voltage wiring is performed only by qualified 
personnel adhering to local electrical standards.

Caution Do not mix hazardous voltage circuits and human-accessible circuits in 
the same cable unless the cables are properly insulated for min. 250V.

Caution Ensure that devices and circuits connected to the module are properly 
insulated from human contact.

Caution Except for the isolated RS232, CAN, IGND, IO Lock terminals, and the 
Ethernet Port, all I/O terminals are hazardous voltage LIVE (> 42.4 Vpk/60 VDC) or 
could be at hazardous potential. You must ensure that devices and circuits connected 
to the module are properly insulated from human contact. External protection must 
be provided to protect any other devices connected to the BATT, DRVP, and MPRD 
supplies.
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Caution Do not operate the DCM in a manner not specified in this document. 
Product misuse can result in a hazard. You can compromise the safety protection built 
into the product if the product is damaged in any way. If the product is damaged, 
return it to NI for repair.

Caution Do not disconnect the power supply wires and connectors from the 
controller unless power has been switched off.

About This Manual
This document explains how to begin using the National Instruments DCM family of devices. 
The scope is limited to focus on initial DCM startup and basic operation using the DCM Starter 
Harness and DSI software. For more detailed information on DCM hardware or software, refer 
to the Related Documentation section of this guide.

Preparing the Environment
Ensure that the environment in which you are using the DCM meets the following specifications.

Note Refer to the device specifications on ni.com/manuals for complete 
specifications. 

Identifying the Hardware
The following section includes identification of DCM kit contents and all other required 
components.

Verifying Kit Contents
Verify that the following item(s) are included in the DCM kit:
• DCM with rack-mount end plates
• NI DCM Getting Started Guide
• NI DCM-2316 Specifications Guide

Operating temperature
(IEC 60068-2-1, IEC 60068-2-2)

0 °C to 55°C

Operating humidity (IEC 60068-2-56) 10% RH to 90% RH, non-condensing

Pollution Degree (IEC 60664) 2

Maximum altitude 2,000 m

http://www.ni.com/manuals
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Required Components (Not Included)
The following items are necessary to set up and use the NI DCM using this document:
• Host/Development PC running Windows 7/8.1/10
• DCM Starter Harness kit
• Piezo or Solenoid Injector
• 12 V or 24 V DC power supply, 180 W1 minimum DC power supply

Software Installation
The DCM may be used with several different software personalities. Each personality requires 
different software packages to be installed on the host computer which may need to be 
individually licensed. 

NI Powertrain Controls supports the following software personalities for the DCM: 
• DCM Default Software Image (DSI)
• NI LabVIEW
• NI VeriStand

DCM Default Software Image (DSI)
Before using the DCM DSI, you must install the following application software and device 
drivers on the host computer in this order: 
• NI CompactRIO Device Drivers 16.0 or later
• Software Calibration Management (SCM) Toolkit 2016 or later (evaluation license)

Note The DCM is shipped supporting the latest version of SCM. If you have 
trouble launching the DCM DSI with the latest available version of SCM on ni.com, 
the software on your DCM may need to be updated. Refer to the NI DCM-23XX DSI 
User Guide for more information.

For minimum software support information, visit ni.com/info and enter the Info Code 
swsupport.

DCM With LabVIEW
Before using the DCM with LabVIEW, you must install the following application software and 
device drivers on the host computer in this order: 
• LabVIEW 2016 or later 
• LabVIEW Real-Time Module 2016 or later 
• LabVIEW FPGA Module 2016 or later 

1    Minimum power supply requirements assume basic operation; actual power supply requirements will 
vary depending on hardware and software configuration.

http://www.ni.com/
http://www.ni.com
http://www.ni.com/info
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• NI CompactRIO Device Drivers 16.0 or later 
• NI Powertrain Controls Device Drivers 2.160.0.0 or later

The NI Powertrain Controls Device drivers may be installed using JKI Software’s VI Package 
Manager. For minimum software support information, visit ni.com/info and enter the Info 
Code swsupport.

DCM With VeriStand
Before using the DCM with VeriStand, you must install the following application software and 
device drivers on the host computer in this order: 
• VeriStand 2016 or later
• NI DAQmx 16.0 or later
• NI VISA 16.0 or later
• NI CompactRIO Device Drivers 16.0 or later
• NI Powertrain Controls DCM Custom Device for NI VeriStand

For minimum software support information, visit ni.com/info and enter the Info Code 
swsupport.

Hardware Installation

Mounting the DCM
The DCM is designed to be flexible in its mounting position. The following mounting methods 
are supported by NI Powertrain Controls:
• Rack-mount: Rack-mounted in a standard 19-in. chassis, 5U

– Requires: Rack-mount kit (included, PN: 785246-01)
• Panel-mount: Firmly secured on a clean, flat surface with connector facing out or up

– Requires: Panel mount kit (optional, PN: 785247-01) 

Connecting the DCM Chassis Ground Lug to Facility 
Ground
You must connect the DCM chassis ground lug to the grounding electrode system of the facility.

What to Use
• Wire, 1.63 mm2 (14 AWG) or larger, or braided grounding strap
• Screwdriver, flat 3/16-in.

http://www.ni.com/info
http://www.ni.com/info
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What to Do
Complete the following steps to ground the DCM.
1. Remove the screw from the chassis ground lug on the DCM.
2. Insert wire or braided grounding strap into the side of the chassis ground lug
3. Tighten the grounding screw to 1.4 N · m (12 lb · in.) of torque.
4. Attach the other end of the wire to the grounding electrode system of your facility using a 

method that is appropriate for your application.

For more information about ground connections, visit ni.com/info and enter the Info Code 
emcground.

Connecting the DCM Starter Harness
The DCM Starter Harness contains all connections required to begin using the DCM with 
one solenoid injector and one piezo injector. The DCM Starter Harness should connect with 
the devices as shown in Figure 1.

What to Use
• DCM Starter Harness
• Hex Driver, 4 mm
• PDU-2300
• Emergency Stop (E-Stop)
• Solenoid and Piezo injectors or dummy loads

What to Do
Complete the following steps to connect the DCM Starter Harness.
1. Ensure that the PDU is disconnected from all power sources.
2. Connect the harness to DCM Connector 1, being sure to orient the connector appropriately.
3. Tighten the DCM connector terminal fastener to 5 N · m (44 lb · in.) of torque using a 4 mm 

Hex Driver.
4. Ensure your PDU is correctly configured for 12 V or 24 V, whichever is used. Refer to the 

Configuring the PDU-2300 section for more information.
5. Connect the harness to the PDU (blue connector).
6. Connect the harness to the emergency stop.
7. Connect Solenoid A1 injector (real or dummy).
8. Connect Piezo A2 injector (real or dummy).

http://www.ni.com/info
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Figure 1.  DCM Starter Harness Connections

Note Many I/O terminals come unpopulated in the DCM Starter Harness kit. These 
connections must be populated by the user in order for the relevant functions to be 
used. For more information about wiring additional I/O, refer to the NI DCM User 
Guide.

Configuring the PDU-2300
The PDU-2300 may be configured for 12 V or 24 V systems. The PDU ships configured for 12 V 
systems by default. Complete the following steps to configure the PDU for 24 V systems. See 
Figure 2 below for illustration of fuse placement for 12 V and 24 V setup. 
1. Open the PDU cover to expose the various relays and fuses.
2. Remove 7.5 A fuses from slots F12 and F13 and set aside.
3. Fill slot F14 (empty by default) with one of the 7.5 A fuses removed in the previous step.
4. Save the remaining fuse as a replacement.

1 PDU-2300 2 Light-duty power supply cables

3 Power supply 4 DCM

5 Heavy-duty power supply cables 6 Emergency stop

7 RS232

7

6

1

2

4

3

5
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Caution Damage may occur if the PDU-2300 is not appropriately configured for 
the selected supply voltage before connecting power.

Figure 2.  Fuse Placement for 12 V and 24 V Setup

Connecting the DCM to Power
Powering the DCM with the DCM Starter Harness kit requires a 12 V or 24 V, 180 W minimum, 
external DC power supply. Recommended power supplies are listed in Table 1 below. The 
light-duty power supply leads (14 AWG) included in the DCM Starter Harness kit are 
recommended only for bench-top applications which require less than 15 A of current. The 
heavy-duty leads (8 AWG) included in the DCM Starter Harness kit are recommended for all 
other applications.

What to Use
• Starter harness light-duty (<15A) or heavy-duty power supply leads
• Wrench, 1/2-in.
• NI recommended power supply 

Table 1.  Recommended Power Supplies

Power Supply Part Number

PULS QS10.121 Power Supply
(12 VDC, 15 A, 100-240 VAC/110-150 VDC Input)

783168-01

NI PS-17 Industrial Power Supply
(24 VDC, 20 A, 100-240 VAC/110-150 VDC Input)

781095-01

Tripp Lite PR 60
(13.8 VDC, 60 A, 120 VAC Input)

PR 60

TDK Lambda Genesys 1500W
(0-30 VDC Variable, 0-50 A Variable, 85-265 VAC input) 

GEN 30-50

12 V Setup

F12
7.5 A Fuse

F14
Empty

F13
7.5 A Fuse

24 V Setup

F12
Empty

F14
7.5 A Fuse

F13
Empty
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What to Do
Complete the following steps to connect power to the DCM.
• Ensure the DCM Starter Harness is connected as discussed in the Connecting the DCM 

Starter Harness section.
• Connect power supply leads terminated with properly rated ring terminals to the PDU 

Positive (+) and Negative (-) input studs.
• Tighten terminal fasteners to 10.2 N · m (90 lb · in.) using a 1/2-in. wrench.
• Connect power supply leads to the power supply. If connecting to a battery, always connect 

the Negative (-) lead last. When disconnecting the battery, always disconnect the 
Negative (-) lead first.

Connecting the DCM to the Host Computer
Complete the following steps to connect the DCM to the host computer or Ethernet network 
using the RJ-45 Gigabit Ethernet port.
• Power on the host computer or Ethernet hub.
• Connect the RJ-45 Gigabit Ethernet port on the DCM to the host computer or Ethernet hub 

using a standard Category 5 (CAT-5) or better shielded, twisted-pair Ethernet cable.

Caution To prevent data loss and to maintain the integrity of your Ethernet 
installation, do not use a cable longer than 100 m (328 ft).

Note The DCM attempts to initiate a DHCP network connection the first time you 
connect using Ethernet. The DCM connects to the network with a link-local IP 
address with the form 169.254.x.x if it is unable to initiate a DHCP connection.

Powering on the DCM
When you power on the DCM for the first time, the device boots DCM DSI. The POWER LED 
illuminates, the STATUS LED illuminates briefly, and then the USER1 LED blinks steadily 
once the DSI executable has booted. Overall boot time is approximately 60 seconds.

Configuring the DCM in Measurement and 
Automation Explorer (MAX)
Complete the following steps to find your DCM in MAX.
• Ensure that any anti-virus or firewall software running on the host computer allows 

connections to the host computer.

Note MAX uses UDP 44525. Refer to the documentation of your firewall software 
for information about configuring the firewall to allow communication through 
UDP 44525.

• Launch MAX on the host computer.
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• Expand Remote Systems in the configuration tree and location your system.
• Select your target.

Tip When DSI is installed on a DCM, MAX lists the system under the model 
number followed by the serial number, such as NI-DCM-2316-1856AAA. If the 
DCM is formatted without the DSI image, MAX lists the system using the format 
NI-sbRIO-9651-1856AAA.

Setting a System Password
Complete the following steps to set a system password.

Note The default username for the DCM is admin. There is no default password 
for the DCM, so you must leave the password field blank when logging in until you 
set a system password.

1. Right-click your system and select Web Configuration.

Note The NI Web-Based Configuration and Monitoring utility opens in your 
default browser and is where you set the password.  If you have not installed 
Microsoft Silverlight, NI Web-based Configuration & Monitoring prompts you 
to do so.

2. Enter a unique name for your system in the Hostname field.
3. Click the Security Configuration icon.
4. Click Login.
5. In the Login dialog box, enter the username admin and leave the password field blank.
6. Click OK.
7. Click Change Password.
8. Enter and re-enter a new password.
9. Click OK.
10. Click Save.
11. Click OK to confirm you are changing the password.

Caution NI cannot recover lost system passwords. If you forget the password, you 
must contact NI and reformat the controller.
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Installing Software on the DCM (LabVIEW or VeriStand 
Personalities)
Complete the following steps to install software on the DCM for LabVIEW or VeriStand 
personalities. If using DCM DSI, skip this section.

Note The DCM ships with the DSI pre-installed. In order to run non-DSI 
personalities, the DCM must be formatted. To reinstall the DCM DSI after 
formatting, refer to the NI DCM-23XX DSI User’s Manual for more information.

1. In MAX, right-click on your DCM target under Remote Systems.

Caution Any files, including calibrations, present on the DCM during formatting 
will be lost. Prior to formatting, any files present on the DCM must be backed up in 
order to be saved. Files may be copied from the DCM by WebDAV file transfer.

a. Select Format Disk.

Tip You must log in if you set a system password.

b. Select Attempt to restart into safe mode.
c. Select the desired option to manage network adapter settings.
d. Click Format.
e. Wait for the formatting process to finish, then click OK.

2. In MAX, expand your system under Remote Systems.
a. Right-click Software.
b. Select Add/Remove Software to launch the LabVIEW Real-Time Software Wizard.

Tip You must log in if you set a system password.

c. Select the recommended software set for your LabVIEW and NI-RIO Device Drivers 
versions.

d. Click Next.
e. Verify that the summary of software to install is correct.
f. Click Next.
g. Click Finish when the installation is complete.

3. To install NI VeriStand or NI SCM on the target, continue with the following steps.
a. In MAX, right-click Software as before.
b. Select Add/Remove Software to launch the LabVIEW Real-Time Software Wizard.

Tip You must log in if you set a system password.



NI DCM-2316 Getting Started Guide | © National Instruments | 11

c. Select Custom software installation.
d. Click Yes.
e. Select any additional software to install (VeriStand Engine, SCM, etc.)
f. Click Next.
g. Verify that the summary of software to install is correct.
h. Click Next.

4. Click Finish when the installation is complete.

Launching DCM DSI
Complete the following steps to launch and begin using DCM DSI.
1. Open NI Software Calibration Management (SCM) Console on the host PC.
2. Select File»Select Target.
3. Choose your DCM on the Select Target drop-down.
4. Select Download Files.
5. Click OK.
6. Click Start Host Application on the SCM Console.

Note The DCM is shipped supporting the latest version of SCM. If you have 
trouble launching the DCM DSI with the latest available version of SCM on ni.com, 
the software on your DCM may need to be updated. Refer to the NI DCM-23XX DSI 
User’s Guide for more information.

Troubleshooting the DCM

Safe Mode and IP Reset
The following figure shows the reset behavior of the DCM.

Figure 3.  Reset Behavior

Run Mode

• Network Settings Reset
• Console Out Enabled

• RT Startup App Disabled
• FPGA Startup App Disabled

Safe Mode with
IP Reset

• Console Out Enabled
• RT Startup App Disabled
• FPGA Startup App Disabled

Safe Mode
Cycle Power

Cycle Power

+AI11 (pin 63) to Batt+
+AI12 (pin 55) to Batt+

Cycle Power

+AI12 (pin 55) to Batt+
Cycle Power

http://www.ni.com/
http://www.ni.com
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LED Indicators
The following table describes the DCM LED indicators.

Table 2.  LED Indicators

LED Name LED Color
LED

Pattern Indication

POWER/LOCK Green Solid The DCM is powered on and I/O is 
Unlocked

Amber Solid The DCM is powered on and I/O is 
Locked

— Off The DCM is powered off

STATUS Amber 2 Flashes The DCM has detected an error in its 
software. This usually occurs when an 
attempt to update the software is 
interrupted. Reinstall software on the 
DCM. Refer to the Measurement & 
Automation Explorer Help for 
information about installing software 
on the chassis.

Amber 3 Flashes The chassis is in safe mode. Refer to 
the Measurement & Automation 
Explorer Help for information about 
safe mode.

Amber 4 Flashes The software has crashed twice without 
rebooting or cycling power between 
crashes. This usually occurs when the 
chassis runs out of memory. Review 
your RT VI and check the memory 
usage. Modify the VI as necessary to 
solve the memory usage issue.

Amber Continuous
Flashing
or Solid

The DCM has detected an 
unrecoverable error. Contact National 
Instruments.

USER 1
USER 2

— — Application dependent

ACT/LINK — Off No Ethernet link

Green Solid Ethernet link established

Green Blink Ethernet activity occurring
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Related Documentation
Your documentation needs may vary depending on the hardware and software you use for your 
application.

Hardware Documentation
• NI DCM User Guide—This document explains in detail the hardware and software features 

of the DCM. This document is available at ni.com/manuals.
• NI DCM-2301 Specifications—Lists the specifications of the NI DCM-2301 device. This 

document is available at ni.com/manuals.
• NI DCM-2316 Specifications—Lists the specifications of the NI DCM-2316 device. This 

document is available at ni.com/manuals.

Software Documentation
• NI Powertrain Controls Device Drivers User’s Manual

– After installing the drivers, select Help»Powertrain Controls»Device Drivers 
User’s Manual in LabVIEW to view the Device Drivers User's Manual. Browse the 
DCM section in the Contents tab for information about the DCM API VIs on the 
FPGA, Real-Time, and user-interface levels.

• NI DCM-23XX DSI User Guide
– Select the Help icon on the Default Software Image (DSI) user interface panel to view 

the NI DCM DSI User’s Manual. 

Additional Resources
• For additional resources and support, including up-to-date software downloads, visit the 

NI Powertrain Controls Users group on ni.com/community.
• National Instruments Example Finder—For detailed LabVIEW examples which highlight 

specific features of the DCM and its software API VIs, use the NI Example Finder by 
selecting Help»Find Examples and searching for “DCM” on the Search tab.

10/100/1000 — Off 10 Mbps

Green Solid 100 Mbps

Amber Solid 1000 Mbps

Table 2.  LED Indicators (Continued)

LED Name LED Color
LED

Pattern Indication

http://www.ni.com/manuals
http://www.ni.com/manuals
http://www.ni.com/manuals
http://www.ni.com/community
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Worldwide Support and Services
The NI website is your complete resource for technical support. At ni.com/support you have 
access to everything from troubleshooting and application development self-help resources to 
email and phone assistance from NI Application Engineers.

Visit ni.com/services for NI Factory Installation Services, repairs, extended warranty, and 
other services.

Visit ni.com/register to register your NI product. Product registration facilitates technical 
support and ensures that you receive important information updates from NI.

A Declaration of Conformity (DoC) is our claim of compliance with the Council of the European 
Communities using the manufacturer’s declaration of conformity. This system affords the user 
protection for electromagnetic compatibility (EMC) and product safety. You can obtain the DoC 
for your product by visiting ni.com/certification. If your product supports calibration, 
you can obtain the calibration certificate for your product at ni.com/calibration.

NI corporate headquarters is located at 11500 North Mopac Expressway, Austin, Texas, 
78759-3504. NI also has offices located around the world. For telephone support in the United 
States, create your service request at ni.com/support or dial 1 866 ASK MYNI (275 6964). 
For telephone support outside the United States, visit the Worldwide Offices section of 
ni.com/niglobal to access the branch office websites, which provide up-to-date contact 
information, support phone numbers, email addresses, and current events.

http://www.ni.com/support
http://www.ni.com/services
http://www.ni.com/register
http://www.ni.com/certification
http://www.ni.com/calibration
http://www.ni.com/support
http://www.ni.com/niglobal
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